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安全声明

小心

小心标志表示有危险。它要求
在执行操作步骤时必须加以注
意，如果不正确执行操作或不
遵循操作步骤，则可能会导致
产品损坏或重要数据丢失。在
没有完全理解指定的条件且不
满足这些条件的情况下，请勿
继续执行小心标志所指示的任
何操作。

警告

“警告”标志表示有危险。它要
求在执行操作步骤时必须加以
注意，如果不正确地执行操作
或不遵守操作步骤，则可能导
致人身伤亡。在没有完全理解
指定的条件且不满足这些条件
的情况下，请勿继续执行 “警
告”标志所指示的任何操作。



安全标志

仪器上及文档中的下列标志表示为了保证仪器的安全操作而必须采
取的预防措施。

直流电 (DC)

交流电 (AC)

直流电和交流电

小心，有危险（请参阅本手册了解具体的“警告”或
“小心”信息）
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安全注意事项

请在使用此仪器之前阅读以下信息。本手册中的描述和说明适用
于 Agilent 模块化产品 系列中的所有仪器。要了解更多相关安全说
明，请参考有关您的 模块化产品 对应的用户指南。

警告 • 如果此设备已损坏，请勿使用此设备。在使用设备之前，请先
检查其外壳。检查是否存在裂缝或缺少塑胶。

• 请勿在含有易爆气体、蒸汽或潮湿的环境周围中使用此设备。

• 建立连接之前，请观察设备上的所有标记。

• 在连接 I/O 终端之前，请关闭设备和应用系统的电源。

• 在维护设备时，请仅使用指定的更换部件。

• 请勿在封盖被拆除或松动的情况下使用本设备。

• 请勿在执行自检过程之前连接任何端子块或电缆。

• 请仅使用制造商提供的电源适配器以避免发生任何意外危险。

小心 • 静电放电 (ESD) 会导致设备和附件中的组件损坏。任何电缆
或电线都应先连接至插入式连接器，然后在将它们插入输出
连接器之前盖上电缆外壳以防止发生静电放电。

• 若未按照制造商指定的方式使用设备，则可能会破坏设备保
护功能。

• 请始终使用干布清洁设备。请勿使用酒精或任何其他挥发性
液体清洁设备。

• 请勿遮堵设备的任何排气口。



法规标记

CE 标记是欧洲共同体的注册商标。
此 CE 标记表示产品符合所有相关
的欧洲法律规定。

C-tick 标记是 Spectrum Management
Agency of Australia 的注册商标。它
表示符合根据 1992 年的《无线通信
发案》的条款制订的 Australia EMC
Framework 规定。

ICES/NMB-001 表示此 ISM 设备符合
加拿大 ICES-001 规定。
Cet appareil ISM est confomre a la norme
NMB-001 du Canada.

此仪器符合 WEEE 指令 (2002/96/EC)
标记要求。此附加产品标签说明不
得将此电气或电子产品丢弃在家庭
垃圾中。

CSA 标记是加拿大标准协会的注册
商标。

此符号表示在所示的时间段内，危
险或有毒物质不会在正常使用中泄
漏或造成损坏。该产品的使用寿命
为四十年。
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废弃电气和电子设备 (WEEE) 指令 2002/96/EC

此仪器符合 WEEE 指令 (2002/96/EC) 标记要求。此附加产品标签说明
不得将此电气或电子产品丢弃在家庭垃圾中。 

产品类别：

根据 WEEE 指令附件 1 中说明的设备类型，将此仪器分类为“监测
和控制仪器”产品。

附加的产品标签显示如下。

切勿丢弃在家庭垃圾中。

要返回不需要的仪器，请与您最近的 Agilent 服务中心联系，或访问

www.agilent.com/environment/product

以获得更多信息。
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符合性声明 (DoC)

可在 Agilent 网站中找到此仪器的符合性声明 (DoC)。可在以下网站
通过产品型号或说明搜索 DoC。

http://regulations.corporate.agilent.com/DoC/search.htm

注意 如果找不到对应的 DoC，请联系您当地的 Agilent 代表。
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Agilent USB 模块化产品和系统
USB 模块化产品和系统概述
USB 模块化产品和系统概述

USB 模块化产品和系统包括一系列测试和测量仪器，可为您提供创
建能够扩展和适应测试要求变化的解决方案所需的选项和灵活性。

图 1 USB 模块化产品和系统系列

模块化产品标准功能摘要

• 配备有高速 USB 2.0 连接，能够提供高达 480 MB/s 的速度

• 操作时需要使用 PC

• 与 Agilent Measurement Manager 软件捆绑在一起，可立即启
动测量

• 支持 Agilent Open 程序，可与多种应用程序开发环境 (ADE) 兼容

• 在与 U2781A USB 模块化仪器机架（最多可容纳 6 个模块）配
合使用时，可作为独立仪器或组合模块进行操作
Agilent USB 模块化产品和系统快速入门指南 11



Agilent USB 模块化产品和系统
USB 模块化产品和系统概述
标准购置物件

有关每个模块化产品的标准购置物件的清单，请参阅模块化产品相
应的用户指南。检查标准购置物件。如果缺少任何物件或存在已损
坏的物件，请联系离您最近的 Agilent 销售处。

检查和维护

初始检查

在收到 USB 模块化产品后，请检查设备在运送过程中是否发生任
何明显的损坏。如果有任何损坏，请立即联系离您最近的 Agilent
销售处。请保留原包装，以便将来将购买的 USB 模块化产品退还
到 Agilent。

常规维护

1 断开设备的电源，然后从设备中拔下电源线和 I/O 电缆。

2 将您的设备从减震器盒中取出。

3 抖掉设备上堆积的灰尘。

4 使用干布擦拭设备并将减震器外壳装回原位。

注意 只有合格的技术人员才能执行您的模块化产品手册中未涵盖的任
何维修服务。
12 Agilent USB 模块化产品和系统快速入门指南



Agilent USB 模块化产品和系统
安装和配置
安装和配置

按照以下流程图中显示的分步说明操作，开始准备并安装 USB 模
块化产品。

图 2 安装和配置流程图

注意 如果要将此 USB 模块化产品与 Agilent VEE Pro、 NI LabVIEW 或
Microsoft® Visual Studio® 软件结合使用，则需要安装 IVI-COM 驱动
程序。

“A. 检查系统”

“B. 安装 Agilent IO Libraries Suite”

“C. 安装模块驱动程序”

“D. 安装 Agilent Measurement Manager”

“E. 将模块连接至 PC”

“F. 验证模块连接”

“G. 启动 Agilent Measurement Manager”
Agilent USB 模块化产品和系统快速入门指南 13



Agilent USB 模块化产品和系统
A. 检查系统
A. 检查系统

在进行任何安装和配置之前，请确保您的 PC 满足下列最低系统要求。

要求 Windows XP 操作系统 Windows Vista 操作系统 Windows 7 操作系统

操作系统 Windows XP Service Pack 3
（或更高版本）[1]

Windows Vista Service Pack 1
和 2 （32 位）[2]

Windows 7 （32 位和 
64 位）[3][4]

处理器速度 需要 600 MHz 或速度更快的处
理器，建议使用 800 MHz

1 GHz 32 位 (x86) 3 GHz 32 位 (x86)

内存 最低 256 MB （建议使用 1 GB
或更高内存）

最低 1 GB 最低 2 GB

硬盘空间 最低 1.5 GB 最低 1.5 GB 最低 1.5 GB

视频 Super VGA (800 × 600) 256 色
或更高

支持 DirectX 9 图形，建议使
用 128 MB 图形内存[5]

支持 DirectX 9 图形，建议使
用 128 MB 图形内存 [5]

CD-ROM 驱动器或 
DVD-ROM 驱动器[6]

必需 必需 必需

浏览器 Microsoft Internet Explorer 5.01
或更高版本

Microsoft Internet Explorer 7
或更高版本

Microsoft Internet Explorer 7
或更高版本

[1] 支持的 Windows XP 版本  — 家庭版或专业版

[2] 支持的 Windows Vista （32 位）版本 — 家庭基础版、家庭高级版、商务版或旗舰版

[3] 支持的 Windows 7 （32 位和 64 位）版 — 家庭基础版、家庭高级、专业版、企业版或旗舰版

[4] 适用于 Windows 7 （64 位）支持的 Agilent Measurement Manager 是一个在 WOW64 （Windows-on-Windows 
64 位）模拟器上运行的 32 位应用程序。

[5]  Windows Vista 和 Windows 7 支持 Super VGA 图形。

[6] 产品附随的介质类型可确定是需要 CD-ROM 驱动器还是 DVD-ROM 驱动器。
14 Agilent USB 模块化产品和系统快速入门指南



Agilent USB 模块化产品和系统
A. 检查系统
软件要求 可用性

IO Libraries Suite 15.5 在 Agilent Automation-Ready CD-ROM 中提供。

Agilent T&M Toolkit Runtime 2.1 版 与 Agilent Measurement Manager 软件应用程序安装程序捆绑在一起。

Agilent T&M Toolkit Redistributable 
Package 2.1 修补程序

与 Agilent Measurement Manager 软件应用程序安装程序捆绑在一起。

Microsoft .NET Framework 2.0 版 与 Agilent Measurement Manager 软件应用程序安装程序捆绑在一起。
Agilent USB 模块化产品和系统快速入门指南 15



Agilent USB 模块化产品和系统
B. 安装 Agilent IO Libraries Suite
B. 安装 Agilent IO Libraries Suite

如果您在 PC 上安装了 Agilent IO Libraries Suite 15.5 或更高版本，
则可以继续到第 23 页上的“C. 安装模块驱动程序”。如果未安装此
程序，请执行此过安装 IO Libraries Suite。

1 验证您的 PC 是否符合最低系统要求。（请参阅第 14 页上的“A.
检查系统”。）关闭 PC 上的所有其他应用程序，准备好 Agilent
Automation-Ready CD。

2 如果您是从 IO Libraries Suite 的早期版本升级到最新版本的
IO Libraries Suite，则必须先删除以下所列的仪器和接口，然后
才能升级软件。

为了使这些设备能够获得使用 IO Libraries Suite 的正确的驱动
程序，此步骤是必需的。

i 从 PC 断开任何 USB 仪器的连接。

ii 从 PC 断开任何 Agilent 82357 USB/GPIB 接口转换器的连接。

iii 从 PC 断开连接到 VXI 接口的任何 Agilent E8491 IEEE
1394 PC 链接。

3 关闭 PC 上所有其他应用程序。

注意 必须拥有管理员权限才能安装 Agilent IO Libraries Suite Connection Expert。

注意 • 如果在安装 Agilent IO Libraries Suite 的同时在计算机中安装 PCI
卡，可能会发生冲突。在继续此安装之前，必须关闭 PCI 卡的
“New Hardware Found”对话框。则， IO Libraries Suite 安装将在
PCI 卡安装完成后才会停止。

• 如果安装了 NI 软件（如 NI MAX 等），则在安装 IO Libraries Suite
之前必须停止所有 NI 服务。
16 Agilent USB 模块化产品和系统快速入门指南



Agilent USB 模块化产品和系统
B. 安装 Agilent IO Libraries Suite
4 将包含 IO Libraries Suite 的 Agilent Automation-Ready CD 插
入您的 PC 的 CD-ROM 驱动器中。等待几秒钟，让自动运行窗
口显示出来。

如果自动运行窗口没有自动显示出来，

• 单击 Start > Run...

• 键入 <驱动器 >:autorun\auto.exe，其中 <驱动器 > 是
CD-ROM 驱动器盘符。

5 在显示安装启动窗口时，单击 “Click here to install now”按
钮一次，并等待 InstallShield Wizard 显示。

注意 每个 IO Libraries Suite 安装都是 “完全安装”

在早期版本的 IO Libraries Suite 中，提供了将 IO Libraries Suite 作为“完
全”版本还是“运行时”版本安装的选项。从 IO Libraries Suite 14.0 开
始，安装过程对所有用户提供“完全安装”选项（也就是说，不再
有“运行时”安装选项）。这意味着每个安装现在都包含 IO Libraries
Suite 软件的开发组件，以便开发您自己的 I/O 程序。如果您要使安
装软件的大小最小化，可选择“自定义”安装；在到达“Select
Features”对话框时，不要选择手册和示例程序。
Agilent USB 模块化产品和系统快速入门指南 17



Agilent USB 模块化产品和系统
B. 安装 Agilent IO Libraries Suite
6 如果 PC 中没有安装 IVI 共享组件和 IVI VISA COM 标准组件，
则 IO Libraries Suite 会在默认位置中安装它们。

7 显示 InstallShield Wizard 后，单击 Next > 开始安装 IO
Libraries Suite 软件。

8 阅读 License Agreement。如果接受这些条款，请单击标签为
“I accept the terms of the license agreement”的单选按钮，然
后单击 Next > 继续。

9 在显示“InstallShield Wizard Setup Type”对话框时（如图所
示），选择 Typical 或 Custom，然后单击 Next >。

注意 也可以观看两分钟的视频，了解如何使用 IO Libraries Suite 15 轻松
安装、设置和配置接口和仪器。

注意 IVI 共享组件和 IVI VISA COM 标准组件将安装在默认文件夹中。但
是，如果要将 IVI 组件安装在某个唯一的位置中，请参阅 Agilent IO
Libraries Suite 连接指南 中的 “IVI 共享组件的自定义安装”。
18 Agilent USB 模块化产品和系统快速入门指南



Agilent USB 模块化产品和系统
B. 安装 Agilent IO Libraries Suite
典型安装将在您的 PC 上的标准位置中安装建议的配置功能。在
典型安装中，如果在此 PC 上已安装了其他供应商的 VISA 软
件，Agilent VISA 将安装为次要程序。如果此 PC 上没有安装其
他供应商的 VISA 软件，则 Agilent VISA 将安装为主要程序。
（另请参阅 Agilent IO Libraries Suite 连接指南 中的“以并列
模式使用 Agilent VISA”。）

10 如果选择自定义安装并且 PC 上没有安装其他供应商的 VISA 实
现，您将会看到下面的对话框，该对话框询问您是否将 Agilent
VISA 安装为主要的 VISA。

如果安装了其他供应商的 VISA，您将会看到类似的对话框，但
不能选中复选框，这表示默认值是将 Agilent VISA 安装为次要
程序。

有关该主题的详细信息，请参阅 Agilent IO Libraries Suite 连接
指南 中的 “以并列模式使用 Agilent VISA”。

注意 • 如果接受 “Typical Installation”，请单击 Next > 前进到步骤 13。

• 如果选择 “Custom Installation”单选按钮，请单击 Next > 前进
到下面的步骤 10。
Agilent USB 模块化产品和系统快速入门指南 19



Agilent USB 模块化产品和系统
B. 安装 Agilent IO Libraries Suite
11 如果选择 Custom Setup，则下一个对话框将显示下列文件夹的
位置：

• IO Libraries Suite 目标文件夹

• Agilent VISA 目标文件夹，以及

• IVI components 目标文件夹

VISA 和 IVI 目标将显示为灰色。它们仅供参考。要更改它
们，必须按照 Agilent IO Libraries Suite 连接指南中“自定
义安装 IVI 共享组件”中的说明操作。

12 如果选择自定义安装，则将会看到“Select Features”对话框。

i 单击列表中的任何功能可查看功能说明以及用于安装选定功
能组的空间要求。如果您计划使用 IO Libraries Suite 进行编
程，则建议您安装手册和示例程序。但您可以忽略其安装以
节省空间。

ii 选中要安装的每项功能的复选框。清除要忽略的每项功能的
复选框。完成选择功能后，单击 Next >。

13 将显示“Start Copying Files”对话框；单击 Install 可开始复制
文件。

如果以前在 PC 上未安装 Microsoft .NET Framework 版本
2.0， IO Libraries Suite 将安装它；这可能需要 10 分钟时间。
Microsoft .NET Framework 提供 IO Libraries Suite 实用程序
以及 .NET 编程工具和许多其他应用程序所必需的基础结构。
即使卸载和重新安装或升级 IO Libraries Suite，也只需要安装
一次 .NET Framework。
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14 复制文件后，将显示询问您是否重启 PC 的对话框。只有在具有
某些 I/O 硬件配置时才会显示该对话框。如果选择此时不重启，
则必须在运行 Connection Expert 之前重启。

15 如果显示 InstallShield Wizard Completed 对话框，则表明已成
功安装了 IO Libraries Suite：

i 单击 Finish 关闭该窗口。

ii 或单击其中一个产品／解决方案链接以了解有关其他
Agilent 解决方案的信息。

16 单击 Windows 通知区域右下方的 IO Control 图标 ( ) 即可运
行 IO Libraries Suite。

17 如果要将 IO Libraries Suite 与其他仪器、接口或软件包 （如
Agilent VEE）一起安装，则可以使用另一张包含附加软件（驱
动程序、示例程序等）的 CD。如果要安装这些软件，

• 请将 CD 插入 PC 的 CD-ROM 驱动器中。

• 按照 CD 或硬件或软件产品附带的说明进行操作。

18 将任何 USB 仪器或 E8491 IEEE-1394 FireWire 重新连接到在
步骤 2 中断开的 VXI 接口。安装任何新硬件。

19 如果 Connection Expert 已在运行，单击 Refresh All 即可识别
已安装或重新连接的任何硬件。

20 如果 Connection Expert 未运行，请立即运行它以验证 I/O 配
置：在 Windows 通知区域中，单击 IO 图标 ( )，然后单击
Agilent Connection Expert。

i 在资源管理器窗格中定位接口和仪器。单击这些接口和仪器
可查看其属性 （显示在右侧窗格中）。查看其状态，这些状
态也显示在右侧窗格中：如果成功建立了与接口或仪器的通
信，则该接口或仪器处于 “已验证”状态，用绿色复选标记
表示。

ii 更改默认 I/O 配置 （如果需要），方法是单击要配置的接口
或仪器的属性窗格中的 Change Properties...。

注意 如果要使用 Agilent 488 API 对 GPIB 仪器进行编程，或将 NI-488.2 兼容
的程序与 Agilent 接口硬件（如 GPIB 卡）一起运行，则可能需要启
用 Agilent 488 库。为此，请单击 Tools > Agilent 488...，然后选中标记
为 “Enable Agilent GPIB cards for 488 programs”的复选框。
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iii 如果要手动测试连接，请选择仪器，右键单击并选择 Send
Commands To This Instrument。

只要可能，您应始终使用最新版本的 Agilent IO Libraries Suite。该
版本支持最新的接口和操作系统，并具有最高级的功能。有关 IO
Libraries Suite 的更多信息，请访问
www.agilent.com/find/iosuite 。

注意 如果在安装 IO Libraries Suite 时遇到问题，请参阅 Agilent IO Libraries
Suite 连接指南 中的 “安装故障排除”一节。

在禁用 UAC 的情况下安装 Vista

如果在安装了 Windows Vista 操作系统的系统上安装 IO Libraries
Suite 时遇到问题，则可能是由于启用了用户帐户控制 (UAC)。通
常，您将看到指出目录名称无效的错误消息。在安装 IO Libraries
Suite 之前必须禁用 UAC。
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C. 安装模块驱动程序

1 验证您的 PC 是否符合最低系统要求。（请参阅第 14 页上的
“A. 检查系统”。）关闭 PC 上所有其他应用程序，然后准备好
Agilent USB 模块化产品和系统产品参考 DVD-ROM。

2 将 Agilent USB 模块化产品和系统产品参考 DVD-ROM 插入 PC
上的 DVD-ROM 驱动器中。等待几秒钟，让自动运行窗口显示
出来。

如果自动运行窗口没有自动显示出来，

• 单击 Start > Run...

• 键入 < 驱动器 >:\\Autorun.exe，其中 < 驱动器 > 是
DVD-ROM 驱动器盘符。

3 在显示安装启动窗口时，单击“Hardware Driver”按钮一次，并
等待 InstallShield Wizard 显示。

注意 • 安装该驱动程序之前，请确保已从 PC 上断开了 USB 模块化产品
的连接。

• 验证安装了 IO Libraries Suite 15.5 版或更高版本，然后再继续。有关
IO Libraries Suite 安装过程的更多信息，请参阅第 16 页上的“B. 安
装 Agilent IO Libraries Suite”。
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4 显示 InstallShield Wizard 后，单击 Next > 开始安装模块化驱
动程序。

5 阅读 License Agreement。如果接受这些条款，请单击标签为
“I accept the terms of the license agreement”的单选按钮，然
后单击 Next > 继续。

6 仔细阅读自述信息。确保从 PC 断开所有 USB 模块化产品设备的连
接。单击 Next > 继续。

7 在显示“InstallShield Wizard Setup Type”对话框时（如图所
示），选择 Typical 或 Custom，然后单击 Next >。

典型安装将在您的 PC 上的标准位置中安装建议的配置功能。

8 如果选择自定义安装，则将会看到 “Custom Setup”对话框。

i 单击列表中的任何功能可查看功能说明以及用于安装选定功能
组的空间要求。

ii 选择“This feature will not available”选项，清除要忽略的每
项功能。完成选择功能后，单击 Next >。

注意 • 如果接受 “Typical Installation”，请单击 Next 前进到步骤 9。

• 如果选择 “Custom Installation”单选按钮，请单击 Next 前进到
下面的步骤 8。
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9 将显示“Ready to Install the Program”对话框；单击 Install 可
开始复制文件。

10 如果显示 “InstallShield Wizard Completed”对话框，则表明
已成功安装了模块驱动程序，单击 Finish 关闭该窗口。
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D. 安装 Agilent Measurement Manager

1 如果在第 23 页上的“C. 安装模块驱动程序”中执行了模块驱动程
序的安装，并且 Agilent Modular Products Installation Menu 仍
为打开状态，则可前进到步骤 4。否则 ，继续下一步。

2 验证您的 PC 是否符合最低系统要求。（请参见第 14 页上的“A.
检查系统”。 ）关闭 PC 上所有其他应用程序，然后准备好
Agilent USB 模块化产品和系统产品参考 DVD-ROM。

3 将 Agilent USB 模块化产品和系统产品参考 DVD-ROM 插入到
PC 的 DVD-ROM 驱动器中。等待几秒钟，让自动运行窗口显示
出来。

如果自动运行窗口没有自动显示出来，

• 单击 Start > Run...

• 键入 < 驱动器 >:\Autorun.exe，其中 < 驱动器 > 是
DVD-ROM 驱动器盘符。

4 在显示安装启动窗口时，单击“Measurement Manager”按钮
一次，并等待 InstallShield Wizard 显示。

注意 验证安装了 IO Libraries Suite 15.5 版或更高版本，然后再继续。有关
IO Libraries Suite 安装过程的更多信息，请参阅第 16 页上的 “B. 安
装 Agilent IO Libraries Suite”。
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5 如果未安装任何预装软件，则会显示 “InstallShield Wizard
Software Prerequisite”对话框。单击 OK 开始安装所列出的
未安装的预装软件。

按照屏幕上的说明操作，安装列出的未安装的预装软件。完成上
述安装后， Measurement Manager 软件的安装将会正常进行。

6 显示 InstallShield Wizard 后，单击 Next > 开始安装 Measurement
Manager。

7 阅读 License Agreement。如果接受这些条款，请单击标签为
“I accept the terms of the license agreement”的单选按钮，然
后单击 Next > 继续。

8 相应地填写 Customer Information Form，然后单击 Next。

9 单击 Next 以安装到指定的文件夹，或单击 Change 以安装到不
同的文件夹。 

10 将显示 “Ready to Install the Program”对话框，单击 Install
开始复制文件。

11 如果显示 “InstallShield Wizard Completed”对话框，则表明
已成功安装了模块驱动程序，单击 Finish 关闭该窗口。将在桌面
上创建此软件的快捷方式。

注意 从 PC 断开所有模块化产品的连接，然后再继续。

注意 许可材料的用途

使用许可材料即表示您接受许可证条款。如果您不同意所有这些条
款，您可以返回所有未打开的许可材料，以获得全额退款。如果许
可材料是捆绑销售或预加载到其他产品中的，则可以返回整个未使
用的产品，以获得全额退款。
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E. 将模块连接至 PC

1 完成所有软件和驱动程序安装后，将电源线连接至 AC/DC 电源适
配器。AC/DC 电源适配器要求输入 100 至 240 V，50/60 Hz 的
交流电，输出电压为 +12 V 的直流电。

2 将 AC/DC 电源适配器的 DC 输出插头插入模块化产品后面板上的
电源插座中。

3 使用附随的电缆将 USB 模块化产品连接到 PC 上的任意 USB
端口。

4 PC 将自动检测到连接的设备并显示 Found New Hardware
Wizard 窗口。选择“Yes, this time only”单选按钮，然后单击
Next 继续。

5 选择“Install the software automatically (Recommended)”，
然后单击 Next。

6 此时会在“Hardware Installation”窗口中显示一条警告消息。

仔细阅读警告，然后单击 Continue Anyway 继续安装此模块化
产品。

注意 • 请确保 Measurement Manager 已安装完毕，然后再继续。有关
Measurement Manager 安装过程的更多信息，请参阅第 26 页上的
“D. 安装 Agilent Measurement Manager”。

• 下图仅用于图示说明，此图可能由于 PC 的操作系统以及所连接
的模块化产品类型的不同而改变。
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7 如果显示 “Found New Hardware Wizard Completed”对话
框，则表明已成功安装了设备软件，单击 Finish 关闭该窗口。

8 此时会显示“Assign USB device alias”窗口。每次插入模块化
产品时，都会显示此对话框。要禁用此对话框，请在 Show this
dialog 面板中选择“Never show this dialog”选项，然后单击 OK。

注意 如果您希望以后不再收到类似警告消息，请按照以下说明操作：

1 单击 Start > Control Panel，然后双击 System 图标。

2 选择 Hardware 选项卡，然后单击 Drivers 面板上的 Driver Signing。将
显示 “Driver Signing Options”对话框。

3 选择 “Ignore”单选按钮禁用该警告消息。
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9 对于除 U2300A 系列、U2500A 系列、U2600A 系列和 U2781A 以
外的模块，系统将在连接的模块上执行固件版本检查。

i 如果模块固件版本与 PC 中安装的版本相同，则不会执行固
件下载。现在可使用模块化产品了。

ii 如果模块固件版本与 PC 中安装的版本不同，那么将显示以
下消息框。该消息框中显示的型号和固件版本可能会因连接
到 PC 的模块的不同而异。

iii 单击 Yes 开始固件下载。此时将显示以下消息框，表示下载正
在进行。该消息框中显示的型号可能会因连接到 PC 的模块
的不同而异。

10 完成固件下载和升级后，即可使用模块化产品了。

小心 在固件下载完成之前不要移除 USB 和电源连接。中断固件下载过
程可能导致设备发生故障。
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F. 验证模块连接

Connection Expert 是 IO Libraries Suite 中的一个实用程序。
Connection Expert 可用于配置连接的仪器并启用通信功能。它可
以自动检测插入 PC 的任何模块化产品。

1 接通 PC 和已安装的模块化产品的电源。

2 如果 Connection Expert 已在运行，请单击 Refresh All 可识别已
安装或重新连接的任何硬件。

3 如果 Connection Expert 未运行，请立即运行它以验证 I/O 配
置：在 Windows 通知区域中，单击 IO 图标 ( )，然后单击
Agilent Connection Expert。

4 显示主屏幕后，您将在 Instrument I/O on this PC 窗格（也称为
“资源管理器窗格”）中看到系统连接图。

注意 下图仅用于图示说明目的，此图可能由于 PC 的操作系统以及所连
接的 USB 模块化产品类型的不同而改变。
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5 检测到的模块化产品将显示在 Instrument IO 资源管理器窗
格中。

在 Explorer 窗格中选择特定仪器时，您将在右侧的 Properties
窗格中看到该仪器的参数 — 如产品号、序列号、 VISA 地址、
GPIB 地址和固件版本。

顶部的绿色复选标记图标表示自动执行了侦听程序检查和标识
(*IDN) 查询。
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6 将使用 Interactive IO 快速验证仪器的连接。 Interactive IO 是一
个软件实用程序，可使用它通过将命令发送到仪器并监视仪器
响应来与仪器进行交互操作。

要从 Connection Exper t  中启动 Interactive IO，请从
Connection Expert 菜单栏中单击 Tools > Interactive IO，或右键
单击 Explorer 窗格中的模块化产品。此时将显示一个上下文菜
单。选择 Send Commands To This Instrument。

7 将显示 “Interactive IO”对话框。单击 Send & Read 以发送
*IDN? 默认命令。仪器的响应应当出现在“Instrument Session
History”面板中。

8 如果 Connection Expert 可以与模块化产品成功通信，则表明
此仪器已正确安装。
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G. 启动 Agilent Measurement Manager

1 双击桌面上的 Measurement Manager 软件图标，或转到 Start >
All Programs > Agilent > Modular Products > Agilent Measurement
Manager 以启动该软件。

2 此时将显示 Measurement Manager 欢迎使用屏幕。

3 将显示 “Select USB Device”对话框，其中显示所连接的模块
化产品。要启动此应用程序，请选择模块化产品，然后单击 OK
以建立连接。在 Available USB Devices 窗格中显示的型号可能
会因连接到 PC 的模块的不同而异。

注意 启动 PC 时， IO Control 将自动启动。

如果在启动 Measurement Manager 时不运行 IO Control，那么会导致无
法与连接到 PC 的任何 USB 模块化产品进行通信。要运行 IO Control，请
转到 Start > All Programs > IO Libraries Suite > Utilities > IO Control。

注意 下图仅用于图示说明，此图可能由于 PC 的操作系统以及所连接的
模块化产品类型的不同而改变。
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4 Measurement Manager 将根据选定的 USB 模块化产品来启动相
应的测量应用程序。有关模块化产品应用程序软件的更多信息，
请参阅 Agilent Measurement Manager Help File。
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USB 模块化产品机架

Agilent U2781A USB 模块化产品机架是能够最多容纳 6 个 USB
模块化设备的可移植机架。它配备有 USB 即插即用接头，符合
USBTMC-USB488.2 标准[1]，因此能够与 Measurement Manager
软件进行无缝操作。

如果购买 U2781A 机架，则可以通过星形触发总线在模块之间增
加同步功能。有关 U2781A 机架的详细信息，请参考 Agilent
U2781A USB 模块化产品机架用户指南。

图 3 连接到 PC 的 U2781A 机架

机架安装

L 型装配架需要安装到您的模块中。下面的说明描述了在 U2781A
机架中安装 L 型装配架以及模块的简单步骤。

1 从包装中取出 L 型装配架。

2 将您的模块从减震器盒中取出。

3 使用十字螺丝刀将 L 型装配架固定在模块上。

4 将模块插入 U2781A 机架中，55 针背板连接器的位置应位于模
块底部。有关详细信息，请参见“55 针背板连接器针脚配置”。

5 通过插槽插入到模块中之后，请拧紧 L 型装配架上的螺丝以确
保牢固连接到机箱。

[1] 仅与 Microsoft Windows 操作系统兼容。
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55 针背板连接器针脚配置

在将您的模块通过插槽插入 U2781A 机架中后，需要使用 55 针背板
连接器。有关 SSI 连接器针脚的说明，请参考表 1。

图 4 55 针背板连接器针脚配置

GND GND GND GND GND GND GND GND GND GND GND F

NC NC NC NC NC NC NC NC VBUS GND USB_D- E

GND TRIG3 GND TRIG2 GND TRIG1 GND TRIG0 GND GND USB_D+ D

TRIG4 GND TRIG5 GND TRIG6 GND TRIG7 GND +12V +12V GND C

nBPUB CLK10M GND STAR_TRIG GA2 GA1 GA0 NC +12V +12V +12V B

NC NC NC NC NC NC NC NC +12V +12V +12V A

11 10 9 8 7 6 5 4 3 2 1

表 1 SSI 连接器针脚说明

SSI 定时信号 功能

GND 接地

NC 未连接

VBUS USB 总线电源感测输入

USB_D+、 USB_D- USB 差分对

TRIG0~TRIG7 触发总线

+12V +12 V 电源，带 4 A 电流

nBPUB USB 背板输入检测

CLK10M 10 MHz 时钟源

STAR_TRIG 星形触发

GA0、 GA1、 GA2 地理地址针脚
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软件驱动程序

Agilent USB 模块化产品和系统产品参考 DVD-ROM 中提供了
IVI-COM 驱动程序和 MATLAB DAQ 适配器的软件组件和应用
程序。

IVI-COM 驱动程序用于在 IVI-COM 环境中对测试仪器进行编程，
MATLAB DAQ 适配器则用于在 MathWorks 环境中控制数据采集
模块化产品 （U2300A 系列、 U2500A 系列 U2600A 系列）。

安装 IVI-COM 驱动程序

选择 Agilent Modular Products Installation Menu 中的 Software
Driver > IVI-COM，然后选中要安装的每个产品系列的复选框。清除要
忽略的每个产品系列的复选框。

图 5 Agilent IVI-COM Driver Installation Menu

注意 • 在安装 IVI-COM 驱动程序之前，必须安装 IVI 共享组件。可在 IVI 网
站中找到 IVI 共享组件，地址是：www.ivifoundation.org 。

• 如果需要，也可从以下站点下载 IVI-COM 驱动程序：
www.agilent.com/find/ivi-com 。
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安装 MATLAB DAQ 适配器

选择 Agilent Modular Products Installation Menu 中的 Software
Driver > MATLAB，然后选中要安装的每个产品系列的复选框。清除要
忽略的每个产品系列的复选框。

图 6 Agilent MATLAB DAQ Adaptor Installation Menu

注意 要将这些设备与 MATLAB 结合使用，您需要安装 MATLAB 和 Agilent
软件组件及应用程序，连接 DAQ 模块化产品，然后安装相应的驱动
程序。可从下列地址获得 MATLAB 示例： 

• www.agilent.com/find/matlab_u2300a ，适用于 U2300A Series DAQ
• www.agilent.com/find/matlab_u2500a ，适用于 U2500A Series DAQ
• www.agilent.com/find/matlab_u2600a ，适用于 U2600A Series DIO

• 有关如何安装 MATLAB DAQ 适配器的更多信息，请参阅相应产品
系列的 Using the USB Multifunction Data Acquisition Devices with
MATLAB Software Quick Start Guides。

• 可以从 MATLAB 安装 DVD-ROM 直接安装 MATLAB 软件，也可以
从 MathWorks 网站进行安装。如果没有 MATLAB 或 MATLAB Data
Acquisition Toolbox 软件，则可从下列地址申试用版：
www.mathworks.com/agilent/daq/tryit.html
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示例代码

为了帮助您快速入门并熟悉使用您的模块化产品，提供了一些
Agilent VEE、LabVIEW 和 Microsoft（C#、C++、VB7 和 VB6）
软件平台的示例代码。

查看示例代码

选择 Agilent Modular Products Installation Menu 上的 Sample
Codes，然后选择首选编程语言类型，如下图所示。

图 7 查看示例代码

命令记录器和代码转换器

使用 Measurement Manager 可快速轻松地进行配置和控制，无需
进行编程工作。要进一步简化您的工作，可使用提供的命令记录器
功能来记录配置命令，并将这些命令轻松转换为 Agilent VEE、
Microsoft Visual Basic、Microsoft Visual C# 或 Microsoft Visual
C++ 代码的代码片断。

• 要启动 Command Logger 功能，请启动 Measurement Manager，然
后转到 Tools > Command Logger...。
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• 要将记录的命令转换为其他语言，请执行以下操作：从 Command
Logger 窗口中，单击 File > Convert Command File。
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激活设备许可证

如果购买了具有一个选件的 USB 模块化产品，则需要先激活设备
许可证，然后才能使用其他功能。可通过 Measurement Manager
中的软件许可应用程序激活设备许可证。

图 8 软件许可应用程序

• 要激活设备许可证，请启动 Measurement Manager，然后转到
Tools > License Panel。

注意 有关如何使用命令记录器应用程序的更多信息，请参阅 
Agilent Measurement Manager Help File。

注意 • 如果未购买具有一个选件的 Agilent USB 模块化产品，则不需要执
行该过程。请参考您的模块化产品对应的用户指南，找到有关可
用于您的模块化产品的选件。

• 如果不想安装 Agilent Measurement Manager，则需要启动软件许可
独立安装程序。选择 Agilent Modular Products Installation Menu 中
的 Software Licensing，然后按照屏幕说明操作。
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• 要验证设备许可证，请从 Software Licensing 窗口中，单击
Verify License > Update License。

注意 将需要使用有效的设备许可证密钥 (*.lic)。如果没有设备许可证密
钥，则需要在 www.agilent.com/find/softwarelicense 中重新获得设备
许可证密钥。按照屏幕上的说明操作，重新获得设备的许可证密钥。

注意 有关如何使用软件许可应用程序的更多信息，请参阅
Agilent Measurement Manager Help File。
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